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VIRTUAL SCHOOL LEADERSHIP

PREPARING FOR YOUR RISE

Principal Mr. Van
Hooks

» Graduate of Detroit
Public Schools

» DPSCD Principal for
4 years

» Educator for 24 years

» Graduate of Western
Michigan University

Principal Ms. Keenmon

Has been teaching in
Detroit for over 2
years

Attended Eastern
Michigan University for
both of her degrees

Loves being outdoors.
Lives with her
husband, and their two
dogs and two cats

Dr. Alspach, Executive
Director

Has her Doctorate in
Education from Oakland
University

Has been leading virtual
education programs for
over 10 years

Her grandparent’s house
was on the same street as
the Virtual School




VIRTUAL SCHOOL LEADERSHIP

Assistant Principal Dr.
Montgomery (K-8)

« Served DPSCD
families for over 25
years

« PhD concentration in
technology in urban
schools

« Education from
Kentucky State, Wayne
State, and University
of Phoenix

PREPARING FOR YOUR RISE

Assistant Principal Assistant Principal
Ms. Seale (9-12) Ms. Miller
Graduate of Detroit « Graduate of
Public Schools Kentucky State
Educator for 16 University
years
Former middle and > ClEELEI OivEine
h|ghhschool English State University
IEEIGEY » Native of Toledo,
Graduate of Ohio
University of
Michigan and

University of Phoenix

Dean of Students Mr.
Gardner

 Dean with the

district for over 16
years

* Founding member of

Detroit PAL Football
& Cheer

e (Graduate of Morris

Brown College



PREPARING FOR YOUR RISE

KEY FACTS

 Live daily instruction with DPSCD teachers
e Full semester commitment

 Failing one core class and chronic absent: probation may be
required to go back to in-person school

* No uniform
* Dress code Is school appropriate

« Students must report to school for in person state testing in April
and May

» Students receive loaner laptop
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EXPECTATIONS

« Students are expected to join their classes daily. K-8 core
subject homeroom teachers will take attendance in the AM & PM
Homeroom Periods. High school is every period.

 The K-8 AM & PM Homeroom periods are generally 1st or 2nd
period & 6th or 7th period.

* When a teacher is absent, building administration will send a link
to the class of the absent teacher through their DPSCD EMAIL
Accounts. The students need to answer the questions on the link
and submit their response. This is how these students’
attendance is captured and saved for official record keeping
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Virtual School Enroliment

Tist l2na ara lath |5t e |7in lsth ot |0t |isth | satn
2 23 42 26 72 79 70 36 41 25 31 53 41

Female Students: 285
Male Students: 257




Text Message Delivery System

The Virtual School's
primary system for
sending messages directly
to parents in through our
Blackboard Connect Robo
Call system.

If you have blocked either
of the DPSCD text
message numbers, you
will not be able

to receive message
related to news and
events for the Virtual
School.
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Message Tracking
082622 Virtual School Parent Orientation
Print Friendly
This message has completed. Blackboard will no longer attempt to deliver it.

{8 Comtent | Details

Delivered

(

Total recipients: 534

Delivered: 427 (72%)
B Mot delivered: 167 (28%)

Text/SMS
Delivered: 427 (72%)

<
2

Total recipients: 534

Delivered - Text Message Received: 370 (62%)
M Delivered - Text Message Sent: 57 (10%)

SMS delivery failed.: 56 (14%)
B Mot delivered - sms number is blocked: 73 (13%)
M Invalid SMS number: 2 (<1%)

Attempted over time:

Batch |D: 4246354
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Parent Expectations

Users opt back into the DPSCD Robo Call System:

- Phone calls: Call the Blackboard Phone Hotline
at "855-502-STOP (855-502-7867)" from the
phone line that has been opted out.

Text (SMS) messages: Reply START to "60680"
from the phone line that has been opted out for
non-emergency messages. Reply START to
"54968" for emergency messages.
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* The DPSCD Virtual BELL SCHEDULE
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detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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SETTING UP YOUR COMPUTER

You should do a few modifications to your
computer to get the best experience in the Virtual
School.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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Pinning Google Chrome

Look for the GOOGLE CHROME If you do not see it click the
ICON. WINDOWS ICON > RIGHT CLICK
GOOGLE CHROME.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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Pinning Google Chrome

Then MORE > PIN TO TASKBAR. You wi

ee the CHROME ICON on
your TASKBAR.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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Setting Up Google Chrome

v ..
. @ . X

Add bookmarks to your favorite Google Apps

”‘c up your browser in a few simple steps e | ) o)
™ o CAd & B
M ake Ch rome your owh ‘ - — e S
Open Chrome, then click GET Check or uncheck your options and

STARTED. click NEXT
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Setting Up Google Chrome

Pick a background

Se
|\

Add bookmarks to your favorite Google Apps

Choose your background’and click Check or uncheck your options and
NEXT. click NEXT.
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Setting Up Google Chrome

D Welcome to Chrome - Set Chron X 4+ A4 - [m] > - 5 N
Settings - [u] ®

u C & Chrome | chrome;//welcome/new-user 2 W A o 2 % &

D Apps M Gmail @B YouTube B Maps Reading li d A e Default apps Reading
- B

Find a setting 2
Set Chrome as your default browser Apps

Music player

Get Google Search and Google smarts = Apps & features ﬂ Groove Music
everytime you browse
35+ Default apps

Photo viewer

i  Offline maps
) [~ R
[ Apps for websites
‘. N Video playback Video player
Movies & TV
& Startup
¢ v

Web browser

E Microsoft Edge
skip L] Set as defaulf [ \

R
Click SET AS DEFAULT. Click MICROSOFT EDGE.




Setting Up Google Ch

Settings

@ Home

Find a setting

Apps

i=  Apps & features
i=  Default apps

% Offline maps

] Apps for websites

X Video playback

=0

Startup

Default apps

- e

Choose an app

Music

S Microsoft Edge
Recommended for Windows 10

ot E Google Chrome

. E Internet Explorer

Video E Microsoft Edge

. Look for an app in the Microsoft Store

Microsoft Edge

Web b

Select GOOGLE CHROME.

2] Reading lis
g
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Settings

@ Home

Default apps

Find a setting

. v

Apps

8= Apps & features

i=  Default apps

@ Offline maps

[ Apps for websites

N Video playback

=0

Startup

Music player

n Groove Music

Photo viewer

- Photos

Video player

E Movies & TV

Web browser

E Google Chrome

Reading lis
g

npd more on all devices

Nhere

No thanks

Then click the X to exit out.
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Linking Your Google Account

Welcome to Chrome X +

C ® Chrome | chrome://welcome/new-user

i Apps M Gmail @B YouTube B¥ Maps

Sign in and turn o‘nc to get your bookmarks, passwords and more on all devices

Your Chrome, Everywhere

No thanks

Click CONTINUE.
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v = [m] x

& Sign in - Google Accounts X +
c & accounts.google.com/signin/chrome/sync/identifier?ssp=18.continue=https%3A%2F%2 Fwww.google.com%2F&flowName=GlifDesktopChromeSync = &
! Apps M Gmail B YouTube B¥ Maps Reading |

Google

Sign in to Chrome

Sign in with your Google Account to get your
bookmarks, history, passwords, and other settings
on all your devices

[ Email or phone |

Forgot email?

Not your computer? Use Guest mode 1o sign in privately.
Learn more

Create accoun =

Click CREATE ACCOUNT. If you
already have a Google account you
want to use, link it here by signing in.
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Linking Your Google Account

_ B o v - g
G Signin - Google Accounts x 4 = m] o 3 Creste your Google Account x  +
« e} & accounts.google.com/signin/chrome/syncfidentifier?ssp=18continue =https%3A%2F%2Fuww.google.coms2F&flowName=GlifDesktopChromeSyne 2 ¥ a2 i C @ accounts.google.com/signup/v2/webcreateaccount?continue=https%3A%2F%2Faccounts.google.com%2FManageAccount%3Fnc%3D1&dsh=5-83185833.. |& W -
i Apps ™M Gmal @B YouTube BY Maps Reading s § Apps M Gmail @ YouTube  BY Maps Reading l
Google Google
Sign in to Chrome Create your Google Account
Sign in with your Google Account to get your — f—
bookmarks, history, passwords, and other settings virtual Student
on all your devices
Usemarne
| @gmail.com
Ema” or phoﬂe You can use letters, numbers & periods
Use my current email address instead
For myself e Q
For my child) Password Confirm
node to sign in privately. One t All of G I
Use 8 or more characters with a mix of letters, numbers & he accoun orbocgle
To manage ess symbols working for you
[] show password
—
Sign in instead Next

Select whether the account is for you Enter your information and choose a
or your child. username and password. Make sure
It is something you will remember!



PREPARING FOR YOUR RISE

Linking Your Google Account ‘

3 Cresteyour Google Account X+ o= g .
o (T — T ———— ————rC TN We su gge st usin g your student number
i Apps M Gmal B YouTube BY Maps Reading I

and student password as your
e oo oo oo information to make it easy to
remember. For example:
12345@gmail.com or
123456 78@gmail.com. If that is not
S available, try your initials followed by
your student number.

First name Lastname
ttttttttttttttt

Usemame

=3
Choose somléﬁing easy to Make sure you write down your
remember! Click NEXT. GOOGLE USERNAME and
PASSWORD too!



Linking Your Google Account

G Create your Google Account X +
= 2 C @ accounts.google.com/signup/v2/webpersonaldetails?continue=https%3A%2F%2Faccounts.google.com%2FManageAccount®%3Fnc#%3D18dsh=5-8318583... 1© Y &

I Apps ™M Gmail @B YouTube B Maps Reading |
] R
Recovery email address (optional) E

We'll use it to keep your account secure

ot Your personal info is private & safe
Mon

January v Day Year

Your birthday

Genger
Custom -

What's your gender?

Please refer to me as -

Why we ask for this information

Back

English (United States) ~ Help Privacy Terms

Enter your information and click
NEXT.

G Create your Google Account

PREPARING FOR YOUR RISE

x  +

@ accounts.google.com/signup/v2/webtermsofservice?continue=https%3A%2F%2Faccounts.google.com%2FManageAccount%3Fnc?3D1&dsh=5-8318583.. |© W &

2t Maps Reading lis

Google
Privacy and Terms

To create a Google Account, you'll need to agree to the
Terms of Service below.

In addition, when you create an account, we process your
information as described in our Privacy Policy, including
these key points:

Data we process when you use Google

= When you set up a Google Account, we store
information you give us like your name, email
address, and telephone number.

When you use Google services to do things like You're in cantrol of the data we
write @ message in Gmail or comment on a collect & how it's used
YouTube video, we store the information you

create

When you search for a restaurant on Google Maps

or watch a video on YouTube, for example, we

process information about that activity — including

information like the video you watched, device IDs,

IP addresses, cookie data, and location

Scroll down to ACCEPT the Privacy

and Terms.
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WHAT IS CLEVER?

Clever is the digital learning platform for DPSCD.
This is one friendly place with single sign-on (sso)
where you can access your learning apps, classes,
and more.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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Logging Into Clever

Detroit Public Schools Community District

Not your district?

=. Log in with Active Directory

Clever

Do Not Use % E E

Having trouble? E I [ ]

Contact info.clever@detroitk12.org

Or get help logging in

Double click the CLEVER ICON. Click LOG IN WITH ACTIVE
DIRECTORY.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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Logging into Clever

» Enter your STUDENT EMAIL (ex:
12345@thedps.org or 12345678@thedps.org) and
click NEXT.



Using Clever

Clever orsco vitua school

Favorite resources

Teacher Pages

Learning Platforms

Microsoft Shortcuts

English Language Arts

Math

Science

Social Studies

Combined Subject
Resources

Computer Science

Languages and
Bilingual Resources

Learning Platforms

® P
PowerSchool

Student Portal

PowerSchool Performance

Schoology @ Micrasoft @
Student Portal Matters

Teams

(2]

Microsoft Shortcuts

W ® =& J

Office 365

Microsoft Word @ Microsoft DPSCD Email - Microsoft Office

PowerPoint Outlock

[}

Hello SMART
Student Login

=

Flipgrid

Performance Matters ° (

[
Stu

You can FAVORITE your most used

apps.

PREPARING FOR YOUR RISE

Clever prsco virtual school

earning Platforms e
Microsoft Shortcuts

English Language Arts

1
KEAR ?.—l In GJ
Math RARGERS
i-Ready myON Sora Web ) Reading Rangers
Science Quick Link
Social St
Math
Combined Subject
Resources
Computer Science GREAT 9
MINDS
Languages and
Bilingual Resources
Great Minds Zearn Math ) Desmos VMath for
Climate, Culture and Manipulatives Calculator Students
Career
More apps Science

You can use the side menu to quickly
access different categories.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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Downloading The Kami Extension

b You cannot add extensions in Incognito or guest windows
rome web store
Go gle KAMI EXTENSION X & Q @
Q Al [ Books [ Videos [@E News [T Images : More Tool Home > Extensions > Kami for Google Chrome™
About 24,000,000 results (0.46 seconds) i -
Kami for Google Chrome Add to Chrome
This search may be relevant to recent activity Search History | Feedback
KAMI EXTENSION for edge &} kamihg.com (& Featured
v % W W W 84607 | Productivity | 10,000,000+ users
https:/ichrome.google.com » kami-for-google-chrome  §

Kami for Google Chrome™

World's #1 digital classroom tool with complete assignment workflow. Annotate and transform
any document

Overview Privacy practices Reviews Support Related
People also search for X

kami extension for google classroom  kami extension for ipad
kami extension download kami extension for firefox

kami app kami extension for mac

kami What is Kami?

hitps:/fwww. kamiapp.com

Kami - Your Digital Classroom Hero | Kami

° [ ]
Create, send, and grade assignments all from one place. Kami works seamlessly with Google W h a l I s Kam '
Mlacernam Manuae and Qehanlame | aamina bananamant Quctame ton

Search for KAMI EXTENSION. What Click ADD TO CHROME.
is Kami? More on that later.
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Downloading The Kami Extension

“ N c O @ google.com/search?q=kami+extensiondrlz=1C1GCEB_enUS990US99080q=KAMI+EXTENSION&ags=chrome.0.0i512I7j69i60.6600j0j1 &sour... 12 Y« W =J
ey / 4
:hrome web store 0 Add "Kami for Google Chrome™? * samanthasylviaheinrich@gma
It can: G 9
oogle kami extension X & Q @3
Home > Extensions > Kamifor Google Read and change all your data on all websites g

Q Al [ Books [ Videos [@ News [&) Images i More Tools
Add extension

Kami for Google

{2 kamihq.com (@ Featured

About 23,200,000 results (0.62 seconds)

https:f/chrome.google.com » kami-for-google-chrome
Y ¥ Y Y W 8.607 | Productivity | 10,000,000+ users Kami for Google Chrome™

World's #1 digital classroom tool with complete assignment workflow. Annotate and transform
any document

hitps:/iwww. kamiapp.com

Kami - Your Digital Classroom Hero | Kami

Create, send, and grade assignments all from one place. Kami works seamlessly with Google
Classroom, Canvas, and Schoology Learning Management Systems too.
Education Pricing - Pricing - Kami Heroes - Leam Kami

0 ‘m https:/iwww.kamiapp.com » google  }

Qverview Privacy practices Reviews Support Related

Google | Kami
Schoology Plus Annotate: Web Annotati... Screen Capture by Kami Screencastify - Screen ... Read&Write for Goog 9 |

One of the most featured apps in the Chrome Web Store. With over 2 million installs and an over
b 4 4. & & F:E Y % % o 281 i 4 4 & & &l o Y o K 11.705 ¥ Y Y ok 20 4 star rating. Kami is a must for every Chrome user.

http://help.kamiapp.com » articles » 2963256-installing i

Installing And Setting Up Kami On Your Device [ @

Click ADD EXTENSION. Click the PUZZLE PIECE ICON.
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Downloading The Kami Extension

& Kamifor Google Chrome™ - Chr X 4+

~ - o v — [m]
& Kamifor Google Chrome™ - Che % +
- C @ chrome.google.com/webstore/detailfkami-for-google-chrome/ecnphlgnajanjnkembpancdjoidceilk/related?hl=en e w #» 0O o - C @ chrome.google.com/webstore/detail/kami-for-google-chrome/ecnphlgnajanjnkcmbpancdjoidceilk/related?hl=en e % 0 o
4 Gmal @B YouTube B¥ Maps . X q Gmail @B YouTube BF Maps
Extensions
No access needed
ail.com v
& chrome web store These extensions don't nexd to see and change & chrome web store £t dpscaviruaiggphi
information on this site
. Kami for Google Chrome™
Home > Extensions > Kamifor Google Chrome’ O amifor Google Chrome

Home > Extensions > Kamifor Google Chrome™
£ Manage extensions

Kami for Google Chrome™

{2} kamihg.com @ Featured

e Y % Y W 8607 | Productivity | 10,000,000+ users

Remove from Chron

Kami for Google Chrome™

{2 kamihg.com (& Featured

i ¥ Y e e 8,607 | Productivity | 10,000,000+ users

Overview Privacy practices Reviews Support Related

Overview Privacy practices Reviews Support Related

o | @ &l

Schoology Plus Annotate: Web Annotati... Screen Capture by Kami Screencastify - Screen ... Read&Write for Google ... Schoology Plus Annotate: Web Annotati... Screen Capture by Kami Screencastify - Screen ... Read&Write for Google ...
Yo ¥ W e ok 84 W ¥ o ek 280 L8 & & & Al % % o & ok 11705 o o Yo ok 2,032 D % % % Ak 280 + % ¥k & 10 Y % % H A 11705 % % % ¥ K 2,032

Click the PIN ICON. Click the SMALL LINE to minimize
your browser.
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WHAT IS TEAMS?

Teams is where your classes are located and
where your teachers or Mr. Van Hooks will post
important updates. Teams holds your calendar and
your meetings.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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Accessing Teams

Clever ppsco virtual school

earning Platforms .
Microsoft Teams

. Favorite resources
Microsoft Shortcuts

English Language Arts b‘,- 4
|
Math
Science
P. VanHooks's Schoology @ Micro
Social Studies Page ea

Resources Teacher Pages Download the Teams desktop app
and stay better connected.

"3
I
Languages and Get the Windows app
Bilingual Resources
Use the web a| ste]
Climate, Culture and " [
's

More apps Legal Privacy and Cookies @ 2021 Microsoft

Click the TEAMS ICON. You should download and install the
WINDOWS APP for the best
selection of features.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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Accessing Teams

_ o _

Feed = B General Posts files Files Channel calendar Home {83 Settings

3 General
) a Philip mentioned DPSCD 825 AM Zoom %)+ 23] Accounts
@ virtual School Students &. é. & Privacy
DPSCD Virtual School Students & Good morning, Cevbonrd shor a “
DPSCD Virtual School Stu... > General ¥ [ Notifications B
Philip mentioned DPSCD 1 Please take 3 moment to raview today's Class Coverage list of Faculty Absences. Ifyourtei  About £ Devices High contrast
aO Virtual School Students &... Check for updates ”
DPSCD Virtual School Students & .. ) App permissions
DPSCD Virtual School Stu... >General Download the mobile app i )
Lo DPSCD Virtual School Faculty Absence Report 04292... ) Captions and transcripts

e Microsoft Teams AadSync

© added you to Social Studie...
Microsoft Teams AadSync
added you te Mathematics...

e Microsoft Teams AadSync ~ 3:20 AM

@ added you to Language Art...

e Microsoft Teams AadSync
@ added you to Science (Gr K.

Microsoft Teams AadSync

[ Files

Compact

Layout

Choose how you want to navigate between teams.

added you to Homercom (...

e 4728

Application
Philip mentioned DPSCD 4/28 To restart, right-click the Teams icon in the taskbar, then select Quit. Then reopen Teams.
Virtual School Students & Staff : Only channel moderators can post in this channel. b

Auto-start application

DPSCD Virtual School Students & ..

DPSCD Virtual Sel Stu... >General

You can change the look of your You can change theme, chat density,
Teams in the SETTINGS. and layout.
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Accessing Teams

—=— -

= Teams

Teams

Your teams

Your teams Chat

. 4d \NB B O

DPSCD Virtual School Mathematics (Gr K) 21-22 - L. Arts (Gi = . .
o ishpepany DPSCD Virtual School Staff ~ e Kk DPSCD Virtual School Mathematics (Gr ) 21-22 - Art (Gr K) 21-22 - E(A)_
FeEe Students & Staff E(A)_VKI1CK VK1CK
&
Callz
SS ." n A
= ,
Social Studies (Gr K) 21-22 - Science (Gr K) 21-22 - E(A)_ Homeroom (Gr K) 21-22 - AM- ﬁ
E(A). VK1CK VKICK PM(A)_ VK1CK
Physical Education (Gr K) 21- Science (Gr K) 21-22 - E(A) Homeroom (Gr K) 21-22 -
22 - E(A)_VKI1CK VK1CK AM-PM(A)_VKI1CK
Apps
@

N

Dark mode look. You will see all of the classes you are
enrolled in under the TEAMS TAB.
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Managing Teams

— - —

_ Ky _
Activity Teams - ég; ivity Teams - i@:
E)‘ * Yourteams 2 I
7 8 Hide
L= o PV
€3 Manag
=N DPSCD Vil A Mathe“;?:)‘s\(;: i Languag 3 Art (GrK) 21-22- E(A) & Addm tual School Mathematics (Gr K) 21-22 - Language
udents - VK1CK e ot ts & Staff E(A)_VKICK E
5
Call alls & Manage tags
* » 1 E
p 4 PE 2
Physu:za; F:dEL:cAa)tI:I;:gLK) 21- Science (G:’ﬂ é:(-zz - E(A). Ho‘::;?:a(;?r 5:(52;(22 ° Physical Education (Gr K) 21- Science (Gr K) 21-22 - E(A)_ Homeroom (Gr K) 21-22 -
- - B 22 - E(A)_VK1CK VKI1CK AM-PM(A)_VK1CK
pps ps
?
Help el

T

You can REORDER vyour tiles by You can HIDE your old classes by
CLICKING AND DRAGGING. clicking on the 3 DOTS and selecting
HIDE.
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Managing Teams

— _ —

= Teams = @ Teams
5 2
| S
E = =
Teams -
Science (Gr K) 21-22 - E(A)_ Homeroom (Gr K) 21-22 -
e DPSCD Virtual School Mathematics (Gr K) 21-22 - Language Arts (Gr K) 21-22 - Physical | VK1CK AM-PM(A)_VKI1CK
Students & Staff E(A)_VKICK E(A)_VKICK 22
&
Calendar
Calls Hidden teams
o
— l B Show
Science (Gr K) 21-22 - E(A)_ Homeroom (Gr K) 21-22 - & Manage
VK1CK AM-PM(A)_VKICK
Art (GrK) 21-22 - E(A)_ o Addmey
VK1CK 3 Getlink ffea
Apps &) Manage tags
%), + Hidden team:

If¥®u accidentally hide a tile, you Click the 3 DOTS then click SHOW.
need you can put it back by clicking
HIDDEN TEAMS.
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Managing Your Calendar

— - —

A%ﬁ Calendar 2 Calendar

Activity
@ B Today < > April 2022 @ B Today < > April 2022 v
Chat Chat
o 25 26 27 28 o 25 26 27 28
o Monday Tuesday Wednesday Thursday e Monday Tuesday Wednesday Thursday
10 AM 10 AM
Assignments @ 5 ) @2 Assignments 2 @2 {5 )
— E Mr. Edwards PE Eanceted:-Mr: Eanceted: Creative-Writing 1044-1136 grade Wednesday & Fridays E Mr. Edwards PE Kindergarten (K /Vklck) — S Mr. Edwards PE Canceted:r: Eanceted:-Creative-Writing 1044-1136 grade Wednesday & Fridays S Mr. Edwards PE Kindergarten (K /Vklck)
[+ ] 11AM 3 Kindergarten (K | EchwardsPE Cassandra Reed Art (Gr K) 21-22 - E(A)_ VK1CK/General 3 Vernon Edwards =] 11AM ¥ Kindergarten (K | EdwardsPE Cassandra Reed Art (Gr K) 21-22 - E{A)_VK1CK/General ¥ Vernon Edwards J
Cale A Vernon Edw- _* Vernon Edward Jennifer Kalb A Calendar § Vernon Edw ' Vernon Edward Jennifer Kalb i
y e @ ae @} ao § ae @ ae @ - f ae
Calls Gills N
12PM Canceled: 12PM Eanceted:
Jame @ Jame @ &
e €anceled-EtAand || Eanceled—Moth Eanceted: €anceted: ELA and FS Eanceled-hath Eanceted: Eanceled—EAand || Canceted:vath Eanceted: Eanceted: ELA and FS CancelectMath Canceted: 1
5 ancHEHA HAand 5 || Mathand Cassandra Reed ancHEEA Math-and F5 and-EHA Cassandra Reed anc-EHA Math-and ]
Cassandra Reed || InterventionF5 Cassandra | B intervention 5 EtA 1py | CosandreReed || intervention§ 1O} View > intervention 5 EA
UL — Reed Intervention anchELA Intervention — — intervention
Cassandra Reed Foand-£tA Cassandra Reed FSancHEEA Cassandra Ree  —, L Cassandra Reed Foamd-EA
(=) Chat with participants
Cassandra Cassandra Cassandra
Reed Reed Reed
2PM 2PM 1 Remove from calendar bl
----------------------------------------- Occurrence
Effice e BHic  Series Cassandra Reed
Cassandra e | )
3pM (o~ (G~ (G~ o) [a] o) o) ® 3PM o 5] 5] o aa @ @@
Help Help

Do you have a messy calendar with REMOVE old things by RIGHT
cancelled and outdated meetings? CLICKING on it. Select REMOVE
FROM CALENDAR > SERIES. If you
don’t see that option...
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Managing Your Calendar

— - Mot e —

=l Calendar pety Calendar
9 @ Today £ > April 2022 ~ - @ @ Today < > April 2022 v~
Chat o View > Chat
- 25 26 , 28 @ 25 26 27 28
e Monday Tuesday {z) Chat with participants Thursday S Monday Tussday Wednesday Thursday
(1 Join online @
e . &> Copy link Assignments e
a8
s ~/ Accept >
?  Tentative >
% B —————————— . 9AM
N Social Studies and Math 52 [ 3 idies and Math
Calls
Cassandra Reed eeline Occurrence 3 Reed
Series
9AM 10 AM
10 A 1AM
il ae ae
= IMr. Edwards PE || Eomcetecin : 1044-1136 grade Wednesday & Fridays  § Mr. Edwards PE Kindergarten (K /Vkick)
11AM §Kindergarten (K || EcwardsPE Cassandra Reed Art (Gr K) 21-22 - E(&)_ VK1CK/General { Vernon Edwards 12PM
@ § Vernon Edw Vernon Edward Jennifer Kalb i i
i ao [~ [EE~) @o i 20 |
Help

REMOVE it by RIGHT CLICKING on Now you have a clean calendar and
it. Select DECLINE > SERIES. are ready to add your new classes!



Adding Your Classes

—

Q < All teams
Activity

Assignments

Class Notebook

Assignments

Calendsr

=Ene Grades

el Channels
General

Mathematics (Gr K) 21-22 - ...

E General Posts Files Clever

- I am sorry, | am out today.

« Reply
April 6, 2022
G 10,2021, 1126 AM
You're meeting was till going when | left. So whenever you are done, you can go to lunch.
&/ Reply
Today

G /2021, 12:47 PM

Scheduled 3 meeting

Sodal Studies and Math
Occurs every work day (Mon-Fri) @8:00 AM

(1 Meeting ended: 3h 15m s

& Reply

Click on a tile to enter your class.
You will see that your teacher has
SCHEDULED A MEETING.

—

< All teams

Mathematics (Gr K) 21-22 - ...

Class Notebook
Assignments

Grades

Channels

General

Click in the PURPLE AREA to open

PREPARING FOR YOUR RISE

E General Posts Files Clever

- I am sorry, | am out today.

« Reply
April 6, 2022

D 1102021, 11:20 AM

You're meeting was till going when | left. So whenever you are done, you can go to lunch.

sf':\-

<’ Reply

Today
G /2021, 1247 PM
Scheduled a meeting

Social Studies and Math

Occurs every work day (Mon-Fri) @8:00 AM

[ Meeting ended: 3h 15m

« Reply

& New conversation

the meeting info.



Adding Your Classes

Q

S
— ]
alendar
calls

Q, Search

s Social Studies and Math chat Details

Add to calendar @ Copylink —> Forward

September 14, 2021 8:00 AM - 10:44 AM
a Mathematics (Gr K) 21-22 - E(A)_VK1CK > General

Occurs every Monday. Tuesday, Wednesday, Thursday and Friday

Microsoft Teams meeting

Join on your computer or mobile app

Click here to join the meeting

Or call in (audio only)
462-.

948358602# United States, Detroit
Phone Conference ID: 948 358 602#

Find a local number | Reset PIN

Track

onp

KH

o

BS

You will see the meeting information.

PREPARING FOR YOUR RISE

—

Social Studies and Math chat Details

Add to calendar © Copylink — Forward
Septe 21 8:00 AM - 10:44 AM
8] B ™ s (GrK) 21-22 - E(A)_VKICK > General

(7] QOccurs every Monday. Tuesday. Wednesday, Thursday and Friday

Microsoft Teams meeting

Join on your computer or mobile app
Click here to join the meeting

Or call in (audio only)
-462. 48!

United States, Detroit

Phone Conference ID: 948 358 602#
Find a local number | Reset PIN

Tracking

a} Cassaee
&N Orga

15 Accepted 2

Kourtlynn Huc
Unknown

Caden Dean
D
Unknown

Bella Sinclair
& Unknown

3
Unknes
~

Lori Harris

Click ADD TO CALENDAR to accept

the meeting.



Adding Your Classes

Microsoft Teams Q. Search

_;%w Social Studies and Math chat Details

9 + Accepted

Chat

© Copylink —> Forward

September 14, 2021 8:00 AM - 10:44 AM

E Mathematics (Gr K) 21-22 - E(A)_VK1CK > General

(iD3
)

Assignments

(7] Qccurs every Monday, Tuesday, Wednesday, Thursday and Friday

2

Call

Microsoft Teams meeting

Join on your computer or mobile app
Click here to join the meeting

Or call in (audio only)
+1313-462-2 948358602# United States, Detroit
Phone Conference ID: 948 358 602#

Find a local number | Reset PIN

U - & ; I
. "

KH

cD

BS

You will now see that the meeting is

ACCEPTED.

PREPARING FOR YOUR RISE

Microsoft Teams Q, Search

Calendar

B Today < > April 2022 v

25 26 27

Monday Tuesday Wednesday

Social Studies and Math Social Studies and Math

10 AM
11 AM

12 PM

28

Thursday

Social Studies and Math

Go to your CALENDAR and you will
see your meeting there.

o




Q

Activity

5]

Chat

sas
w

Assignmerf

Calenda

&

Calls

dding Your Classes

< All teams

athematics (Gr K) 21-22 - ...

Channels

General

Q, Search

E General Posts Files Clever

- I am somy, | am out today.

' Reply
April 6, 2022

1/30/2021, 11:29 AM
You're meeting was till going when | left. So whenever you are done, you can go to lunch.

2 replies fro-@D
' Reply
Today

p/14/2021, 12:47 PM
Scheduled a meeting

== Social Studies and Math

Occurs every work day (Mon-Fri) @8:00 AM

mEw

[l Meeting ended: 3h 15m s

< Reply

Go back to the TEAMS TAB.

—

Assignments

Calendar

&

Calls

Apps

Help

< All team:

H

Mathematics

Class Notebook
Assignments

Grades

Channels

General

PREPARING FOR YOUR RISE

rK)21-22 - ...

E General Posts Files Clever

I am sorry. | am out today.
&' Reply
April §, 2022

G o200 1125

You're meeting was till going when | left. So whenever you are done, you can go to lunch.

2 repies fronHNEID)
« Reply
Today

G, o1, 1247 00

Scheduled a meeting

Social Studies and Math
Occurs every work day (Mon-Fri) @8:00 AM

(1 Meeting ended: 3h 15m 5

&' Reply

Then ALL TEAMS to REPEAT the

process and add the rest of your

classes to your calendar.
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Pining & Un-Pinning From The Sidebar

Microsoft Teams o e —
ing...

:E%‘., m Edu Class Notebook chat About

Gt
Chat
520
.0 Your teams w
. s
i
Teams

(3

8
# e
d Q —
Assignments Find an app
. Coonr B
0
Calendar 6

mA-al-o—aio-ser ) 21-22 - DPSCD Virtual School E

& R unn 1K Art (G ) 21-22 - E(A). VK1CK Students & Staff B e e ok e
. d You're starting a new conversation
OneNote Power Power Bl Shifts

Automate Type your first message below.

BEEAE -

PE . T e, e

Physical Education (Gr K) 21-22 Homeroom (Gr K) 21-22 - AM-
Help - E(A)_VK1CK PM(A)_ VK1CK @Ib A © B 0 & @ - .

You can PIN and UN-PIN different Click the app you want to PIN.
apps from your TEAMS SIDEBAR by
RIGHT CLICKING.



Pining & Un-Pinning From The Sidebar

Then RIGHT CLICK and select PIN.

PREPARING FOR YOUR RISE A

Activity

Chat

Teams
Assignments
Calendar
Calls

Files
OneNote
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Joining Your Class Meetings

e e
=8 Calend -+ New meeting
[ Today < > April2022 ~ [B) Work week
Social Studies and Math Social Studies and Math Social Studies and Math
assand Cassandra Reed

Mr. Edw

Kk larerge

lernon Jennifer Kalb

You always will know where you're
supposed to be in you go to your

You can change your
BACKGROUND by clicking on the 3
CALENDAR. Look for the RED LINE
and the DARK PURPLE meeting. DOTS then SHOW BACKGROUND
Click JOIN. EFFECTS.
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Joining Your Class Meetings

Select a fun background then turn it
on!

Use the icons in the menu to turn
on/off your camera and mic, raise
your hand, chat, or see attendees.
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Download The Mobile App

Download the Teams app to your
phone for emergencies if you can't
access your computer, or your
Internet is down.



PREPARING FOR YOUR RISE

: @ WHAT IS POWERSCHOOL?

PowerSchool is the District’s student information

) system. It is the boss of all of our apps. Parents,
PowerSchool guardians, and students can log in and view
grades, attendance, and class schedule at any
time.



Using PowerSchool

Clever DPSCD Virtual School

Favorite resources

Teacher Pages

Learning Platforms

Microsoft Shortcuts

English Language Arts

Math

Science

Social Studies

Combined Subject
Resources

Computer Science

Languages and

Click the POWERSCHOOL
STUDENT PORTAL Icon.

P.VanHooks's
Page

Learning Platforms

©

Schoclogy @

&

Microsoft
Teams

Microsoft Shortcuts

P & J <

(2]

PowerSchool
Student Portal

PowerSchool
Student Portal

Performance Matters

Performance
Matters 9

Nffire ARG

Hello SMART
Student Login

PREPARING FOR YOUR RISE A

H@ PowerSchool SIS

weicom NG

" . 4
Navigation

g_‘ Grades and
“H Attendance
Grade History
l%) Attendance
History

Teacher
Comments

Student
Reports
Forms

School Bulletin

Class
Registration

Balance

My Schedule

cl ¢ ¥

Grades and Attendance:v

Grades and Altendance

Last Week

Exp

M T WHFMTWHF

AM-PM(A)

E(A)

E(A)

E(A)

E(A)

E(A)

Standards Grades

This Week

Attendance By Class

Course

Q1

Qz s

Q3 Q4 s2 Y

You can click through the tabs on the

left to see different data.



Using PowerSchool

H@ PowerSchool SIS

Y

Navigation
g_‘ Grades and
"E Attendance

Grade History

Attendance
History

Teacher
Comments

Student
=) Reports
FO[mE
School Bulletin

Class
Registration

% Balance

@ My Schedule

4

Student Reports“

~ Currently Published Reports

Accessing Clever At Home
Student Credit Standing

~ Archived Reports

Report Name

VS Standards Progress Report Grades K-2
Kindergarten DVS Report Cards 020722
Standards Progress Report Grades K-2

Date Archived
03/11/2022
02/07/2022
12/13/2021

Click the STUDENT REPORTS tab to
View your progress reports and

report cards.

H@ PowerSchool SIS

PREPARING FOR YOUR RISE A

wetcorquiiNY

Navigation

g—‘ Grades and
"E Attendance
?@ Grade History

Attendance
History

Teacher
Comments

Repots
Forms
School Bulletin

Class
Registration

% Balance

‘ @ My Schedule

4

My schedul ST

Week View Matrix View

B Enroliments for DPSCD Virtual School only

Monday Tuesday Wednesday Thursday
04/25/2022 04/26/2022 04/27/2022 04/28/2022
08:00 AM | Homeroom (Gr K) 3] Homercom (Gr K) (3] Homeroom (Gr K) (4] Homeroom (Gr K) (4] Ho
-
1 1 1 1 1
08:00 AM - 11:00 AM 08:00 AM - 11:00 AM 08:00 AM - 11:00 AM 08:00 AM - 11:00 AM 08:
03:00 AM
10:00 AM
11:00 AM | art icr k) B articry B articrri B articri B an

Click the MY SCHEDULE tab to view
your class schedule.



Using PowerSchool

m@’ PowerSchool SIS

Student and Parent Sign In

Forgot Username or Password?

Students: If your login doesn't work, ask your front office staff for a Student Web Access
Letter.

Parents: To create an account for the first time, you will need an Access ID and Password. To
get this information, reach out to your school and request a Web Access Letter. Parent Web
Access Letters are available in Arabic, Bengali, English, French, Hmong, and Spanish

There is also a POWERSCHOOL
PARENT PORTAL.

PREPARING FOR YOUR RISE

Parents must come to the building to
receive the Parent Web Access Letter.

The I.D. and Password listed on

the Access Letter are used to create your
own account, with a unique username
and password of your choice.

The |.D. and Password are not how you
actually log into the system

Once you've downloaded the app and
have your Parent Web Access Letter the
4-digit District Code for DPSCD is PSNW
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WHAT IS SCHOOLOGY?

Schoology is the District’'s most popular learning
management system. This is where you will find

and turn in most of your assignments. Schoology
links for PowerSchool to record students' grades.



Using Schoology

COURSES GROUPS RESOURCES GRADES

RECENT ACTIVITY COURSE DASHBOARD

| Event

Philip vanHooks » DPSCD Virtual School

@ Goed morning!

Join us far today's morning announcements by dlicking on this link at 8am.

@@ 042722 Morning Announcements
htps://bit.ly/30DmDrz

Apr 27,2022 at 7:59 am - Like

@ 2 people liked this

Philip vanHooks » DPSCD Virtual School

@ Good morning,

Please take a moment to review today's Class Coverage list of Faculty Absences. If your teacher and section are on
this list, check your email in about 15 minutes for directions and the link to submit your attendance for today to the

main office.

Shaw Mere
i DPSCD Virtual School Faculty Absence Report 042622 pdf 125 k2 | 4 viEw

Tue Apr 26, 2022 at 8:22 am - Like

Most Recent

Overdue

MONDAY, JANUARY 24, 2022

MONDAY, APRIL 11, 2022

@..

e collag

gnmel

pm

Upcoming

The first thing you will see is the
RECENT ACTIVITY. Check here for
Important updates from Principal Van
Hooks and your teachers.

PREPARING FOR YOUR RISE

RSES GROUPS RESOURCES GRADES

COURSE DASHEOARD

Most Recent

DPSCD Virtual School

ant to review today's Class Coverage list of Faculty Absences and Proctors for 3rd Grade M-STEP
fyour teacher and section are on this list, check your email for directions and the link to submit
r today to the main office.

il School Faculty Absence Report 050622, pdf 122ke | “view [ ope

ke

DPSCD Virtual School

=nt to review today’s Class Coverage list of Faculty Absences. If your teacher and section are on
email for directions and the link to submit your attendance for today to the main office.

Overdue

MOMDAY, JANUARY 24, 2022

sment 1-t

pm

@ Kindergarten art assignment 5- Romare Beardon
of person)collage(art made

technique{cut and paste)

11:5% pm
THURSDAY, JANUARY 27, 2022

] art-

11:59 pm

MONDAY, APRIL 11, 2022

You will also see all of your overdue
If any) and your upcoming
assignments.
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Using Schoology

St

(Soli; 1= GROUPS  RESOURCES  GRADES

COURSES GROUPS RESOURCES GRADES

PUBLIC SCHOOLS

PUBLIC SCHOOLS

Courses Courses
. — h 2 .
& r\ ¥ Al b & A c AT
| b
OME | S0 | .

n ' ' :
Art(GrK) Homeroom (Gr K) Language Arts (Gr K) Lunch Art(GrK) Homeroom (Gr K) Language Arts (Gr K) Lunch
21-22 - E(A): VKICK 21-22 - AM-PM(A): VK1CK 21.22 - E(A): VK1CK 2122-1 21-22 - E(A): VK1CK 21-22 - AM-PM(A): VK1CK 21-22 - E(A): VK1CK 21-22-1
DPSCD Virtual School DPSCD Virwal School DPSCD Virtual Schoo DPSCO Vi DPSCD Virtual Schaol DPSCD Virwal Schoal DPSCD Virtual Schoo DPSCD Vi

[ ] [ ]
— -9
a | a .
Mathematics (Gr K) Physical Education (Gr K) science (Gr K) Social 5 Mathematics (Gr K) Physical Education (Gr K) science (Gr K) Social 5
21-22 - E(A): VKICK 21-22 - E(A): VK1CK 21-22 - E(A): VK1CK 21-22 -1 21-22 - E(A): VKI1CK 21-22 - E(A): VK1CK 21-22 - E(A): VK1CK 21-22 -t
DPSCD Virtual School DPSCD Virtual Schaoal DPSCD Virtual Schoo DPSCD Vi DPSCD Virtual School DPSCD Virtal School DPSCD Virtual Schoo DPSCD Vi

T TSRS T TATSTIST, CNECK your eman Tor amrecuons ana e K To SuDmIT your aenaance Tor To0ay 1o Tne maln oTmce: TR TSR T Y

collage ~ Shu Mars

TITS TIST, CIECK yOur erman Tor aimecons ana e TNK 10 SunMmiT your aienaance Tor Toaay Tor e aiT oTnce:
collage

R S I

Click on the COURSES tab to view Click on a CLASS TILE to view our
all of your classes. weekly folders and other materials
your teacher has added.
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Using Schoology

Skt

COURSES GROUPS RESOURCES GRADES COURSES GROUPS RESOURCES GRADES

DETROIT
PR sco0Ls

Language Arts (Gr K): 21-22 - E(A): VKICK » 5.5.22

Language Arts (Gr K): 21-22 - E(A): VK1CK HE —
ursday

DPSCD Virtual Schoal

Upcoming - 51 FS M3 C20 L103 % immersive
All Materials
i Material h
@ Materials T D‘Z/I ELA PDF Workhook @ aterials If you type the sentences instead of writing them, you will not get full points. o
[} Submissions
Updates Updates Posted Thu May 5, 2022 at 1:32 pm
] Grades ﬁ 4.18.22 ml| Grades El 5.5.22.png.Kami 160 k8 ‘ (3 Open Assignment With Kami | L34 | B2 Submit Assignr
Mastery Mastery freers
] 22522 §
.
,;.. Attendance = Attendance s -
9. Members - 5.5.22 9 Members -
W srainror B erainror @@ o
k* Edpuzzle &* Edpuzzle
LearnZillion *=| LearnZillion
Information Information
EfA) E(A)
Grading periods Grading periods
2021-2022: 9/7/21 - 6/27/22, 2021-2022: 9/7/21 - 6/27122,

Click the FOLDER of the week to You can view your assignment and
view your assignments. the directions from your teacher.
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Using Schoology ‘

Language Arts (Gr K): 21-22
- Thursday

__________

This will open a new window in your
Some assignments are worksheets, browser. You can sign in with your new

which require you to write on them. Google account or your school email.
Click OPEN ASSIGNMENT WITH KAMI.  We recommend your Google account

because it works best with Kami.
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Using Schoology

J Clever| Portal % | @ FSM3C20L103|Schoclogy % () Virtual Student-5522pngKam X + e - o ’ Kami [P [0 © & KamiSchoolo.. » Virtual Student - 5.5.22.png.Kami.pdf

c @ web.kamihg.com/web/viewer.html?state=%7B"ids"%3A%58" 11xcCbBENUgsnMGyX9IL_ZilDrgdM9z3Y"%5D%2C action'%3Acpen'%.. & =2 s @ ®» O o

Complete Sign Up

Almost there! Tell us more,
so0 we can customize Kami to your needs.

I am using Kami for

Click through the sign up. You can draw on the page with the
mouse or use your touch screen.
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Using Schoology

ami 0 © & KamiSchoolo.. » Virtual Student-5.5.22.png.Kami.pdf

=
3

[0 2 & KamiSchoolo.. » Virtual Student - 5.5.22.png.Kami.pdf

helfg |™ P
= @ =] ~ [ = |
You can make a text box to type, Click TURN IN, then TURN IN again
highlight, and more. Use the left to turn in your assignment.

menu to complete your assignment.



Using Schoology

COURSES GROUPS RESOURCES GRADES

PREPARING FOR YOUR RISE

Do

S COURSES GROUPS RESOURCES  GRADES
DETROIT

Virtuzal Student - 5.5.22.png.Kami.pdf Comglet=

This will close the Kami window and
take you back to Schoology. Click

SUBMIT to submit your assignment.

PUBLIC SCHOOLS

Language Arts (Gr K): 21-22 - E(A): VK1CK

Language Arts (Gr K): 21-22 - E(A): VK1CK
DPSCD Virtual School

Material
2021-2022: 9/7/21 - 6/27/22  (33.33%) —
Updat
Elﬂﬂ Grad lasswark —
Mastery
Bea Friend to Trees U2 L12 _—
=, Attend.
D Members ELA M3 U1 L11 —
B eainror
ELA Be a Friend to Trees —
k* Edpuzzle
ELAM3UT LI -0
= | LearnZilli
Information ELAM3UT L2 —
E(A)
Grading periods ELAM3UZ LY —

2021-2022: 9/7/21 - 6/27/22,

You can click on GRADES to view
your grades and your past
submissions.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200
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WHAT IS KAMI?

Kami is a browser extension that allows teachers to
share pdf documents with students. Students can
write on the document as if they are writing on a
sheet of paper in a face-to-face classroom.




*  Welcome to Kami

+ Let's get started with some fun octivities so you can +

get to know the amazing Kami tools and features!

1. Use the Text Box tool to write your name:
Got (reatrvs - charge thee oxhgreuna b ary cobor e ware

+

PREPARING FOR YOUR RISE

KAMI

*To use Kami, students can sign up using their
DPSCD student email account.

*Kami is being automatically installed to all District-
owned devices. In the event Kami does not install
as a Google Chrome Extension on a district
device, this article will walk you through how you
can manually install the Kami extension.


https://www.kamiapp.com/

PREPARING FOR YOUR RISE

WHAT IS i-READY?

I-Ready is an online program for reading and/or
mathematics that will help your student'’s

_ teacher(s) determine your student's needs,
-Ready personalize their learning, and monitor progress
throughout the school year.

I-Ready allows your teacher(s) to meet your
student exactly where they are and provides data
to increate your student's learning gains. i-Ready
consists of two parts: Diagnostic and Personalized
Instruction.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200



/r'\
SharePOint \ /O Search across sites
; &

e ______ W T -~

PSCD Stud o Sohool Direciofies:

e=+ WHAT IS THE STUDENT
HUB?

——

The Hub is a one stop shop for Det.rf
students to receive important 9:c
updates, get access to District

resources, view the District

calendar, and access all their My F
learning management tools.

—— > 4 You

Sumtt mer Leammq: . i

dents hone skills First day of school aniby

in Sound Mind, Sound Body I chiss it August 29t

Lear
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The Student Hub

SharePoint A Search across sites m Translate

Clewr DPSCD Virtual School

DPSCD Student Hub  Clever PowerSchool Code of Conduct Academic Calendar School Directories v

Favorite resources L . Platf
earnin atrorms
g Sk The Student Hub

[ H
( ) e - > lome
o N N N
®
HD Perfarmance Matters
PowerSchool
Student Portal

Meet Perriel Pace, a rising Legacy

Teacher Pages

Learning Platforms

Microsoft Shortcuts

How to check your A '

i:tgs“Sh Language Schoology @ Microsoft o PowerSchool Performance @ Hello SMART grades, attendance in Dr. Vitti: Welcome
Teams Stuclent Portal Matters Student Login Academy student leader! PoweiSchool your Student Hub!
Math

M

AV
Science C’}
Social Studies x My Resources

Combined Subject DPSCD "@ @ E 51)0 & [E

R
esourees Student Hub 0

PowerSchool \ Schoology Homework Tech Help Support My Email What's for
for Students Hotline Services Lunch?

Computer Science

Mirrncnft Chartritc

You can get to the STUDENT HUB The Hub contains a lot of helpful
from CLEVER or Office 365 information for students.
Sharepoint.
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WHAT IS THE
POWERSCHOOL
PARENT PORTAL?

PowerSchool is the
District’s student
iInformation system. Here
Powe r SC h OOI you can create one
account to view your
students’ grades,

attendance, progress
reports, and report cards.

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200



PowerSchool Parent Porta

e About Us COVID Information Parents Community Schools Departments Calendar

\III/
\\\ '4/ Select a School v | want to... ¥

enroll my child log Into online
learning tools

ek
@ ! i’\ find a school
: ., _ apply to an

m Iﬂnd Iout whaksior examination high
Hnen school
request my transcripts apply to an Yaiil Robeson
find a Job application school Spelling Bee
connect with the access distance
School board learning

this K-8 DPSCD

"BARENT ACADEMY [Eries

2022 WINTER COURSE CATALOG log_Into PowerSchool
FREE VIRTUAL COURSES OPEN TO ALL PUBLIC ParentPortal D Education
''''''' D BY THE W.K. KELLOGG FOUNDATION | FOX 2’3

onizéyaand
’ : - S REp
1I"'m looking for something else >

o
(5

~w\

Cﬁ Covid Information m Connected Futures Employment

C/;. Enroll ‘:] Lunch Menus

Scroll down for more User Options ‘

www.detroitk12.org/site/Page/8920

You can access the PowerSchool Parent
Portal from the DPSCD website:
detroitk12.org. Click | WANT TO then
LOG INTO POWERSCHOOL
PARENTPORTAL.
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O (O) https://detroitk12.powerschool.com/public,

"JS;') PowerSchool SIS

Student and Parent Sign In

Sign In Create Account

Username

Password

Forgot Usermame or Password?

Students: If your login doesn't work, ask your front office staff for a Student Web Access

Letter

Parents: To create an account for the first time, you will need an Access 1D and Password. To
get this information, reach out to your school and request a Web Access Letfer. Parent Web

Access Letters are available in Arabic, Bengali, English, French, Hmong, and Spanish

Copyright ® 2005-2022 PowerSchool Group LLC and/or its affiliate(s). All rights reserved

All trademarks are sifher owned or licensed by PowerSchool Group LLC and/or its affiiates.

Privacy Policy

{\;

Guest (&

Or go directly there at
detroitk12.powerschool.com/public.
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PowerSchool Parent Portal

Create Parent Account

”Fj) PowerSchool SIS Parent Account Details
First Name
Student and Parent Sign In Lasttiams
Email

Sign In Create Account Re-enter Email

Desired Username

Create an Account

Password
Create a parent account that allows you to view all of your students with one account. You can Re-enter Password
also manage your account preferences. Leam more. word Be
8 ch:

lony lowercase leter number
Create Account ¢

Link Students to Account

Students: If your login doesn't work, ask your front office staff for a Student Web Access
Letter.

Parents: To create an account for the first time, you will need an Access ID and Password. To
get this information, reach out to your school and request a Wen Access Letler. Parent Web
Access Letters are available in Arabic, Bengali, English, French, Hmeng, and Spanish Student Name

. 2nd Relationship tyou wish to add to

Access 1D

Access Password

Copyright & 20052022 PowerSchool Group LLC and/or its affiiate(s). All ights reserved

All trademarks are either owned or licensed by PowerSchool Group LLC and/or ils affiliates Relationship - Choase -

Privacy Policy .

Click the CREATE ACCOUNT tab. Enter your details, your desired

username, and password. You will
then CREATE ACCOUNT button. ~eed a PARENT WEB ACCESS

LETTER your teacher(s) will provide
you with.



PowerSchool Parent Portal

Az or M

DPSCD Virtual School

To the Parent or Guar
Our school uses  smodent information system called PowerS ps.fidetroitk] 2 powerschool comipublic).
This is 2 web-based sysiem that pr i to veew smper mfermaticns. We hope this
accessibilty to data sall assst ¥ou a5 we work together 1o provide the best leaming oppornnites for vour

student
‘Your Public Portal Account gives you access ta:

o Goades + Assignments
« Student Schedule + Repon Cards
* Atiendance « Register for email alerts

Serting Up Your PowerSchoal Accomnt
Tfyou have never used the PowerSchool Public portal before, you will need to set up yous account. For thas
process, you wall need an email address and the unsque stadent mfomation prinied below

In the Link Stadents to Account section. enter
the following informaticn

[Student Name: ey
Access ID:
Access

[Password

Relationship:

Note: Studens Access Idenrifiers are ursque for
aach studers.

If you would kike 1o link more than one student 1o
your accout. enter each stwdent's unsque access
sdentifiers m the following rows
PowerSchool will send you a0 email to verify your account. Use this emal 1o complete setup

Navigate 1o
bips.detre

Click on the Create Account tab

e Pt Accoust Des ecion coer

onur e, exmal, ane set up 8 username and. Creste Parent Account
password

Make note of fhe usemame and password you
enter, us they will be used each time you log
nio the portal

Please koep your pazswords and wernames
confidannal. ParentGuardian usernames and
passwarsis can be shared between parertz.

Accevang Your PowerSchool Account

From the Web:
Access your PowerSchool account anytme at bips.

The PowerSchool Mobile App can be downlosded from the App Stere on your 50 device. ox the Play Store cn
your Andrord devace. Search for “PowerSchool” to find the app.

The first time you logn 1o the PowerSchool app from your phone or tablet, you will be asked to cnter the
Distrct's unsque four digit code.
District Code: PSNW

From the sign in screen, enter your usemame and password to log in to your account

Each student has a uniqgue ACCESS
ID and ACCESS PASSWORD.

PREPARING FOR YOUR RISE A

weicom QNN
H@ PowerSchool SIS

4

Navigation
Grades and Attendance‘“

? Grades and
“E Attendance
Grades and Attendance Standards Grades
Grade History
Attendance Attendance By Class
I@ History _
Last Week This Week
Exp Course Q1 Q@2 S51 Q3 Q4 s2 X
%} Teacher
Comments
") Student AM-PM(A)
&~ Reports
Forms EA)
School Bulletin E@)
W Class E(A)
Registration :
Balance E(A)
My Schedule E(A)

Your PowerSchool Parent Portal will
look similar to the Student Portal.
Use the TABS on the left to navigate.
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HOW TO CONTACT YOUR TEACHER

itk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200



How To Contact Your Teacher

You can find all your teacher’s
contact information in their
TEACHER PAGE on Clever.

PREPARING FOR YOUR RISE A

Your teacher will have OFFICE
HOURS weekKly. If you or your parent
wants to speak to your teacher. You

can join the OFFICE HOURS
meeting.



How To Contact Your Teacher

File

Untitled - Message (HTML)

Message Insert Draw Options Format Text Review Help Acrobat
ﬁj ~ < B I U & A = =
B From ~ student@thedps.org
Send

Always try to EMAIL your teacher
first if you have an issue

PREPARING FOR YOUR RISE

If your teacher cannot help you solve
the problem call the Main Office,

email virtual.school@detroitk12.org,

detroitk12.org/virtual | virtual.school@detroitk12.org | 313-644-0200

or reach out to a Principal or
Assistant Principal
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DPSCD VIRTUAL SCHOOL STUDENTS

& STAFF TEAMS TILE
* This includes all students and staff
* |Important updates from Principal Van Hooks
DPSCD Virtual School Students
& Staff » Weekly news & notes
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DPSCD Virtual School Students & Staff Teams Tile

d, Philip VanHooks posted &10522AM Goto message

DV

DPSCD Virtual School ?'ease take 2 moment to revien t:ra;;siafss i-?.-e'e;ei.s: of Fe:u;;Absmnes. I ..-:;-lra#ra':'si:: on are on
tres list, Check your email Tor dirscions and tne Subenit your attendande bor [0Gay 0 he miin oimde.
Students & Staff .

Morning announcements Teacher absences



Weekly
newsletters

PREPARING FOR YOUR RISE

Virtual School Family Newslett... Q Search

Qo File Home Insert Draw Design Transitions Animations v

Open in Desktop .
Activity

o Ov [Ov ] Newsidev Elv [d | A~ A" B

- 5 |
B R

o EE 1 DPSCD Virtual
PR — School Family

signments
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Tech Hub

The Tech Hub at our location will close after the first week of school.

 Live Support - Live remote technical support staff are ready to help if there
are issues with your computer settings or installed software, such as
Microsoft Teams. They are available to students Monday - Friday from 9 a.m.
to 4:30 p.m. Visit for remote assistance.

« Loaner Laptops - If you need support with a school device, please contact our
Customer Care team at (313) 240-4377. They are available Monday - Friday
from 7 a.m. until 5 p.m.

 Learning Apps - If you are having trouble with learning apps like i-Ready, CPM,
or LearnZillion, ask your teacher to email for
assistance.


https://techsupport.detroitk12.org/
mailto:%20info.clever@detroitk12.org

=
o
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Homework help links



https://detroitk12.sharepoint.com/sites/curriculuminstruction/SitePages/Homework-and-Mental-Health-Hotlines-Resume!1.aspx

DPSCD

D2 Z0Y\S  Grab and Go Meals

= SCHOOL

Four regional Grab and Go meal sites will operate this year. Virtual
School students can pick up means at:

 Fisher Upper

« Mumford

 Earhart

« Central High School

Meal distribution will occur each Monday and Thursday from 9 a.m. until
1 p.m. once school starts

STUDENT RISE. WE ALL RISE.

SAFELY EDUCATING STUDENTS ONLINE & IN-PERSON PUBDLEJ SRC%BLS

—_




